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Outlook Archive Feature 1 

Clogged Mailboxes 

The more we use Outlook, the more we create, receive and accumulate files that increase the 
size of our mailbox.  The file size can increase pretty quickly if you use certain options such as 
the journal or have large file attachments or rarely delete sent items. 

You want to maintain the smallest Outlook data file as possible because your mailbox resides 
on the server, which is shared space for everyone in the Saint Rose community. Outlook will 
also run a lot faster.  You are allowed a maximum of 1 GB of data or about 1024MB or 
1,048,576 KB for your email.  This is a lot of space for email.  Nevertheless, some of us may 
have received an email message from the system administrator advising us that we are over the 
limit.  This is a call for some spring cleaning!  There are several things you can do to reduce the 
size of your mailbox. 

Empty Deleted Items folder upon exiting 

Some preventative measures you can take are to Empty Deleted Items folder on a regular 
basis.  By selecting this option, Outlook automatically empties your deleted items folder every 
time you close out of Outlook.  This is the equivalent to the garbage taking away your garbage 
every day.  Deleted items are stored on the server for up to 2 weeks and can be recovered 
through the web interface in case you deleted something you should not have. 

1. From the menu bar select Tools, Options.  Click on the Other tab. 

2. Select the Empty the Deleted Items folder upon exiting check box.  Click OK. 

 

3. You should also periodically empty or archive your Sent items folder. 
4. Lastly, but certainly not least, you should Archive your files frequently in order to maintain 

a reasonable file size in Outlook. 
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Mailbox Size Properties 

The size of your mailbox directly effects performance.  If Outlook runs slow, it is a sure sign that 
it is time to do some email maintenance and archive.  Your mailbox is limited to an average of 1 
gigabyte of space or 1024 megabytes or 1,048,576 kilobytes.  How do you know how much 
space your mailbox is taking up?  To view this information for your entire mailbox, right-click on 
the folder at the top of your folder list, called Mailbox - user name.  Look at its properties. 

1. In your folder list right-click on your mailbox.  Select Properties for Mailbox. 

 
2. In the Outlook Today dialog box select Folder Size. 
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3. This will display the folder size dialog box.  This dialog box will display two tabs if in Cached 
Exchange mode, which is the default installation of Outlook at St. Rose. 

Cached Exchange Mode creates a copy of your mailbox and stores it using an offline folder 
(.ost) file on your computer. This copy provides quick access to your data and is frequently 
updated with the mail server.  If you work offline, whether by choice or if there is a connection 
problem with the Exchange server, you can still access your data. When the connection is 
restored, Microsoft Outlook automatically switches back to connected mode. Any changes you 
made while offline are automatically synchronized once connected. 

View Mailbox Size 

You can also go to Tools → Mailbox Cleanup →View Mailbox Size. 

 

This will display the folder size for your mailbox and subfolders.  Below is an example of the 
folder size dialog box for a cached Exchange mode folder stored on the Exchange Server.  It 
has two tabs Local Data and Server Data.  For the most part, these two tabs should display the 
same sizes for the folders listed.  Click the Server Data tab. 

 
  

An easy approximate 
conversion of KB to MB is 
to take off the last 3 digits 
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Conversion 

Your folder size should be under 1 GB.  If your folder size is over 1GB, or 1,048,576 kilobytes 
you can tell where the culprit lies by looking in the folder size dialog box list.  You can then 
choose to delete items out of those folders, or archive. 
 Outlook displays the size in kilobytes (KB). Just do the conversion.  An easy conversion is 

to take off the last 3 numbers.  For example, I have a total mailbox size of 90,453KB.  This 
converts to about 90MB.  A 1,000 MB = 1 GB.  I am way under my limit. 

 1,048,576 kilobytes = 1 gigabyte. 1,024 kilobytes equals 1 Megabyte. 

But to be more precise, try the converter website listed below 

• http://www.123marbella.net/en/free-bandwith-calculator.html 

1. Just type in the number of kilobytes that Outlook indicates in the total size and click the 

conversion  button.  Look at the number of Gigabytes to determine if it will fit on 
your USB stick.  

 
  

http://www.123marbella.net/en/free-bandwith-calculator.html�
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Archive 

An archive is a file containing old messages that have been moved from the mail folder.  
Archived messages can be retrieved by opening the archive folder.  So, archiving is a method 
for “moving older stuff to the attic” (e-mail messages, appointments, tasks, journal entries, and 
notes).   If you use Outlook frequently, you will accumulate a lot of information – usually e-mail 
messages.  There are three main reasons to archive items in Outlook: 

1. To reduce email glut and clutter. 

2. Store items out of the way (such as those related to a past project) that you might not need 
at the moment, but may need to refer to them in the future. 

3. To maintain a small mailbox size that takes up less space on the server.  The smaller your 
mailbox, the faster Outlook will run. 

Archiving your messages will move them from the server unto your local computer.  Archived 
messages are moved from your inbox to a special data file called archive.pst which is stored 
on your local drive and can only be displayed in Outlook. 

Folder structure 

An identical folder structure exists between the archive file and your mailbox. 
Folders are left in place after being archived, even if they are empty. 

You work with the items the same way you work with items in your main 
mailbox. 

 The subfolders in the Archive mirror the Mailbox. 

 

 

 

Attachments 

 Any files attached to an email such as a Microsoft Word document are also archived within 
the e-mail message. 

To view an online tutorial at the Microsoft website on this topic go to: 
http://office.microsoft.com/training/training.aspx?AssetID=RC102388191033&pid=CR10065458
1033 
There are two sets of Auto Archive settings this class will cover. 
 Default
 

 settings 
per-folder settings (right click folder in navigation pane, click properties, Auto Archive tab) 

http://office.microsoft.com/training/training.aspx?AssetID=RC102388191033&pid=CR100654581033�
http://office.microsoft.com/training/training.aspx?AssetID=RC102388191033&pid=CR100654581033�
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Manual Archive 

Manual archive allows you to archive a particular folder using the default settings or by 
specifying the folder(s) and date in which to archive items. 

1. From the menu bar select File, Archive. 

2. The archive dialog box appears.  Select the desired options detailed below.  Click OK. 

3. In the bottom right hand corner of your status bar, an archiving icon displays indicating that 
Outlook is archiving.  Do not interrupt this process. 

 
 

 

  
 

Note: To exclude an item from being archived, select the “Do Not AutoArchive” property for 
an individual item.  Open the item and choose File, Properties, then check the “Do 
not AutoArchive this item” box. 

 

Moves items to the archive file based on the default or individual settings for each folder. 

Archives items for 
which you have “Do 
Not AutoArchive this 
item” selected.  
Thereby, overriding 
the setting. 

Click the drop-down 
arrow to display the 
date navigator and 
select a date.  This 
Archives items older 
than the date you 
specify here. 

 

The Location where the Archive file 
is stored on your computer. 

 

Select the folder 
you want to 
archive. 

It archives items in 
the selected folder 
that are older than 
the date you 
specify. 
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View Archive Folders 

Outlook archived files (.pst files) are data files saved in a special format and can only be opened 
using Outlook.  After Outlook archives items for the first time, you can access items in the file 
directly from Archive Folders in your Outlook Folder List. 

 If the Folder List is not visible, select Folder List from the Go menu. 

1. Click the plus + sign next to Archive Folders in the Folder List, and any subfolders to 
view contents. 

 
2. It will display the contents in the same folder structure they had before being archived. 

 
 If still you do not see your archive, make sure you have the option “Show archive folder in 

folder list” turned on.  Go to Tools → Options → Other tab, AutoArchive.  Select “Show 
archive folder in folder list”. 

 
Note: You will not be able to access your archive from a web based email account, because 

your archive is not saved on the server.  If you need to access something from home 
that is in your archive you can go to the Archive folder in outlook, click and drag it back 
to your Mailbox folder ahead of time. 
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Auto Archive 

Instead of manually archiving your messages, you can turn on the Auto Archive feature to 
automatically archive on a schedule, along with other options. 

To turn on AutoArchive and configure the global archive settings do the following: 

1. From the menu bar select Tools, Options, click the Other tab.  Click the  AutoArchive 
Button. 

2. Select the Run AutoArchive every n days check box.  Type or choose a number in the box 
for how often you want AutoArchive to run.  The default setting is for AutoArchive to run 
every 14 days.  

 
3. Click OK to save your AutoArchive settings.  Click OK once more to exit the Options dialog 

box. 

4.  If you choose to be prompted before it archives you will get a dialog box as shown below. 

 

Select this to have 
Outlook prompt you 
each time it is about to 
perform the Auto 
Archive, you can click 
Yes or No to continue 
or stop the operation. 

This is the default 
location where your 
archive will reside  

Delete expired email items, refers to 
mail in which the sender turned on the 
expiration feature in delivery options.  
Any message for which an expiration 
date has been set will be deleted after 
the message has expired. 

Click to have all folders follow the 
same AutoArchive schedule. 

Choose an archive interval of 
days, weeks or months 

This option deletes all messages in all your 
e-mail folders, such as Inbox, Sent, or 
Drafts, when they reach the end of their 
aging periods. If you select this option, 
email will be permanently deleted, not 
archived. I suggest un-checking this item. 
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When Auto Archive is turned on, it will run automatically at scheduled intervals, clearing out old 
items.  Old items are those that reach archiving age.  Outlook will auto archive according to the 
default aging period for each type of item. Both the folder and all Subfolders are archived 
according to the default archive settings listed below. 

Item Default Aging Periods for when items in folders expire. 

Inbox 6 months from date received or modified.  For email messages, any action 
such as forwarding, replying, or moving to a different folder are all 
modifications which will affect the date of archive. Items are Auto Archived 
after they reach a certain age or “maturity” date.  "Maturity" means how 
long a message sits around without your touching it. 

Calendar 6 months from start date or last modified. 

Tasks 6 months from the completion date or last modified.  

Incomplete tasks are not archived.  Tasks assigned to others are archived 
only if marked complete. 

Notes 6 months from entry date or last modified 

Journal 6 months from entry date or date modified 

Drafts 6 months from date created or last modified 

Sent Items 2 months from date item was sent 

Deleted Items 2 months from date item was deleted 

Contacts folder N/A – is not auto archived. Does not expire. However, you can manually 
archive them. 

Junk Email folder does not get archived 

Basically when the aging period starts is the received date/time or when you last changed and 
saved the message, whichever is later. 

http://office.microsoft.com/en-us/outlook/HA102511271033.aspx?pid=CH101130681033 

 

http://office.microsoft.com/en-us/outlook/HA102511271033.aspx?pid=CH101130681033�
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Set Archive Options for Individual Folders 

You may also set archive options for individual folders.  The per-folder settings override the 
global default settings so you can Auto Archive individual folders differently. If you don't specify 
AutoArchive settings for a specific folder, the folder will not be archived. 

1. To set the archive options for a folder, select and right-click on the folder. 

2. Choose Properties.  Click the AutoArchive tab. 

3. Set the options you want for the archive of this folder and then click OK. 

At the folder level, you can choose: 

 Do Not Archive items in this folder. 

For example, I have my global AutoArchive settings set to archive everything every six 
months.  However, I may have a folder for a major project that I don't want to Archive, or 
want different settings. In this case I would select “Do not archive items in this folder”. 

 Archive Items in This Folder using the default settings. 

 Archive This Folder Using These Settings.  You can specify any number of days, weeks, or 
months. 

 
4. Click OK when done. 

 Inbox, Notes, and Drafts do not have Auto Archive activated automatically.  Contacts can 
be manually archived, but cannot be Auto-Archived. 

Automatically moves 
items marked to be 
archived by the specified 
time into a file. 

 

Warning! - Permanently 
removes items that are 
older than the amount of 
time you specify. 

    

 

Choosing this option 
moves archived items to 
this specific archive folder. 

This path can be set in 
global AutoArchive 
settings. 
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Exclude items from Archiving 

If there are items in a folder that you want to exclude from automatic arching, you can do so a 
per-item basis. 

To prevent the item from being archived, open the item.  Select, File  → Properties.  Select the 
check box marked do not AutoArchive this item.  Click OK. 

 

Summary 

AutoArchive is just one of the many ways you can use to manage the size of your inbox.  The 
ease of use makes AutoArchive a popular and relatively simple method for moving older 
Outlook items out of your Exchange server mailbox on a regular basis. 
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Backup your Archive to a USB stick 

Once you have archived your mailbox, it is off the mail server and now saved on your hard 
drive.  In the unfortunate event of a hard drive failure, you would lose all your archived items.  
As with all your files and folders it is good to back things up.  In Outlook you Export to do this. 

You Export the archive as a (.pst) personal folder file.  This file can only be opened in Outlook. 

First you have to make sure that your USB drive is large enough to store your archive file.  
To do this, check the size of your archive file to make sure it will fit on the USB stick.  Right-
click on your Archive folder.  Select Properties for Archive Folders.  Click on Folder Size.  
Refer to the conversion information on page 4 if you need to. 

Export 

Export is used to create a file containing your Outlook information, while maintaining the 
original data in your folders.  Export can be used to create a backup of your archive or you can 
Export specific items such as contacts. 

1. Go to File → Import and Export. 
2. In the Import and Export Wizard, choose Export to a file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click Next. 
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4. Choose Personal Folder File (.pst) 

 
5. Select the folder you want to export.  For example, I want to export my Archive.  Scroll down 

and click on Archive folders. 

 
6. IMPORTANT:  Click Include subfolders.  Click Next. 
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7. In the Export personal folders dialog box you want to give it a meaningful name. 

8. Click Browse to go to your USB drive so it saves it there.  Choose Do No export duplicate 
items.  Existing data will be kept, and the duplicate information in the file will not be copied 
to the current Outlook folder. 

 
9. Browse to your USB drive and if you haven’t already done so, type in a meaningful name 

such as Outlook Archive Backup or contacts depending on your purpose. 

 
10. Click OK.  Click Finish. 

 

 

Navigate to your USB drive.  The 
letter designation may be different 
than what is shown here.  
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11. In the Create Microsoft personal folders dialog box, type in the name of the Personal folder.  
Click OK. 

 
12. Name the file and click OK. 

13. Click Finish. 

14. It will export your data in a .pst file format that can only be opened in Outlook.  This may 
take awhile depending on the size of your archive. 

 
15. Check your Flash Drive to check that the archive backup is there.  You are done! 

 



 Information Technology Services The College of Saint Rose 

Outlook Archive Feature 16 

Opening .pst files 

1. If you ever have to restore your backup of your archive, it is a .pst file that can only be 
read in Outlook.  Therefore you will have to open your backup from Outlook. 

2. Follow these instructions to open a .pst file in Outlook.  From the menu bar select File→ 
Open → Outlook Data File. 

 
3. The “Open Outlook Data File” dialog box will open to the default location where .pst files 

are usually stored.  This is usually buried in your profile in documents and settings.  

4. You need to navigate to the USB drive where your backup resides.  In this example it is 
the F Drive. 

 
5. Select the .pst document.  Click OK to close out of the “Open Outlook Data File” dialog 

box. 

 



 Information Technology Services The College of Saint Rose 

Outlook Archive Feature 17 

6. The pst file will display near the bottom of the folder list in the navigation pane, usually 
after archive folders.  You can open your folders and view your items here. 

7.  

 
8. When you are done viewing your file, right click and choose Close. 

 

 

Resources:  http://office.microsoft.com/en-us/outlook/HA101057061033.aspx 

http://office.microsoft.com/en-us/outlook/HA101057061033.aspx�
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